Table of Contents

LXR•TEST 6.1 ...................................................................................................... 4
What is LXR•TEST 6.1 ...................................................................................... 4
Who is Affected by 6.1 ................................................................................... 4
Why 6.1 ............................................................................................................. 4
Benefits of LXR•TEST 6.1................................................................................. 5
Installing 6.1 ...................................................................................................... 6
  New Customers ............................................................................................. 6
  6.0 Customers ............................................................................................. 6
  Install via the internet .................................................................................. 6
  Initial Install of 6.1 for 6.0 Customers .......................................................... 7
Maintenance Releases of 6.1 ........................................................................... 7
What Happens When I Update to 6.1............................................................... 7
After Installing 6.1 ........................................................................................... 8

What’s Different in 6.1? ...................................................................................... 8
A Recommendation on Numbers of Groups per Database ............................... 9

Using the 6.1 Features ....................................................................................... 9
Students Database ............................................................................................ 9
  Naming Student Groups ................................................................................ 10
  Importing into Student Groups ..................................................................... 11
  Adding Student Groups ............................................................................... 12
  Selecting and Navigating Between Student Groups ..................................... 13
  Renaming Student Groups .......................................................................... 13
  Deleting Student Groups ............................................................................ 13
  Exporting Student Groups .......................................................................... 13
  Reports and Student Groups ....................................................................... 13
  Numbers of Groups, .................................................................................... 13
Grading Database ............................................................................................. 14
  Naming Grading Groups ............................................................................. 14
  Importing into Grading Groups ................................................................... 15
  Adding Grading Groups ............................................................................. 15
  Selecting and Navigating Between Grading Groups .................................... 16
  Renaming Grading Groups ......................................................................... 16
  Deleting Grading Groups .......................................................................... 16
  Exporting Grading Groups ......................................................................... 16
  Reports and Grading Groups ................................................................... 16
Online Database .............................................................................................. 16
  Database Synchronization .......................................................................... 17
  Online Setup Window ................................................................................ 18
  Naming Groups ......................................................................................... 18
  Associating Tests ....................................................................................... 18
  Scored Exams ............................................................................................ 19
  Online Access Window ............................................................................... 19
  Online Reports Window ............................................................................. 20
  Adding Online Groups ............................................................................... 21
  Navigating between Online Groups ............................................................ 25
LXR•TEST 6.1

What is LXR•TEST 6.1
LXR•TEST 6.1 contains enhancements to improve support of high-volume online LAN and web testing by reducing the number of databases that must be upsized for online testing.

Who is Affected by 6.1
All new customers and customers updating from a version of 6.0 will be using 6.1.

LXR•TEST users who do not administer LXR•TEST online tests will not be impacted by the new features. They will use 6.1 just as they used 6.0; however, the first time they update to 6.1 they will be prompted for their LXRTEST 6.0 license code.

LXR•TEST users who administer online tests may want to take advantage of the 6.1 enhancements.

LXR•TEST 6.1 will have no practical impact on users who do not administer online tests.

Why 6.1
LXR•TEST 6.0 supports the use of upsized databases (Microsoft Access to Microsoft SQL) for online LAN and web testing. In 6.0, utilizing upsized databases is necessary to support concurrent access to online tests. Access databases were designed for small workgroups and not intended for unlimited concurrent access and scalability.

Assuming online tests are to be accessed by concurrent examinees, each Online database must be upsized and if the online test references Scores, Students, and Grading databases, all of those databases must also be upsized.

The upsizing process consists of:

- opening the LXR•TEST database in Access and upsizing it with the Upsizing Wizard
- launching SQL Enterprise Manager and setting permissions on the upsized database so that online examinees can access the database
LXR•TEST 6.1 Guide to 6.1 Enhancements

• creating a Data Source Name using the Data Sources (ODBC) utility so that the upsized database can be opened in LXR•TEST and so that LAN examinees can access the database
• deleting or moving the Access database so that it’s never accidentally accessed rather than the upsized database

For a single online test referencing Scores, Students, and Grading databases, the above steps would have to be performed 4 times.

Although not technically difficult, upsizing a set of databases is time-consuming. 6.1 is the first step by LXR to simplify implementation of high volume online testing by reducing the number of databases that must be upsized.

Benefits of LXR•TEST 6.1

In 6.0 users can store score information for up to 500 tests, in a single database, through the use of Test ID's so it’s already possible to associate one Scores database to multiple Online tests. LXR•TEST 6.1 provides additional support for:

• multiple groups of students in the same Students database through the use of ‘Group Numbers’ which behave in the same fashion as Test ID’s, and user-defined ‘Group Names that further identify the Group Numbers
• multiple grading tables in the same Grading database through the same mechanism described above
• multiple online tests in the same Online database through the same mechanism described above

Support for the above features means fewer databases to upsize and maintain as part of online testing. In the best case, a user could implement multiple online testing using only:

• a single upsized Online database containing all of their online tests, separated and identified by Group Number and Name
• a single upsized Students database containing different groups of students for different online tests, separated and identified by Group Number and Name
• a single upsized Scores database containing multiple score groups for different online tests, separated and identified by Test ID’s
• a single upsized Grading database containing multiple grading tables for different online tests, separated and identified by Group Number and Name
• A single DSN for each of the upsized databases

Installing 6.1

New Customers
New customers will install from CD and follow the installation instructions in Chapter 2 of the *LXR•TEST 6.0 User’s Guide*.

6.0 Customers
6.0 customers installing 6.1 may:

• Install via the internet if they are covered by the Automatic Software Maintenance (ASM) service
• Install from CD (for a nominal fee)

Contact sales@lxr.com for questions or details about updating to 6.1.

Only those 6.0 customers who have purchased a maintenance contract will be able to download and install the 6.1 release.

Install via the internet
LXR•TEST 6.1 is available to 6.0 customers to install via the internet from the Start > Programs > LXR•TEST 6.0 menu. From this menu users can choose:

• LXR•TEST Update via Internet – this updates the core LXR•TEST software
• Student LAN Client Update via Internet – this must be performed on any computer running the Student LAN Client
• Web Server Extensions Update via Internet – this must be performed on the web server computer only

6.0 customers should install all components they make use of.
Initial Install of 6.1 for 6.0 Customers
If 6.0 had been properly licensed, the installer will not prompt for a license key. If for some reason 6.0 had not been properly licensed, users will be prompted for a license key. This key can be found on the CD sleeve in the front cover of the User’s Guide that was provided with the software or on the original invoice. If you cannot locate either of these materials, send an email to sales@lxr.com for assistance.

Maintenance Releases of 6.1
LXR generally makes a maintenance release of the product available every 3-6 months. The maintenance release contains fixes and typically minor enhancements.

If your organization has a maintenance contract, someone in your organization should check every three months or so to see if a new release is available. To find out what release you are running, launch LXR•TEST, go into Help > About LXR•TEST, and note the release version, 6.#.#.#. To find out if there is a newer release than the one you are running go to:

http://www.lxr.com/support~online~currentsoftware.htm

What Happens When I Update to 6.1
LXR•TEST 6.0 and 6.1 can peacefully co-exist on the same computer indefinitely, although once a user starts using 6.1, there is no reason to still use 6.0.

When 6.1 is installed or updated to, a new menu item, LXR•TEST 6.1, will be installed in the Start > Programs menu. You launch 6.1 in the same manner as 6.0; from that menu, or from a desktop shortcut you create.

Existing Projects in 6.0 will be reflected in Projects in 6.1.

Once launched, 6.1 looks just like 6.0 except for the new fields in the Students, Grading, and Online databases. LXRTEST 6.1 will display in the title bar of the LXR•TEST application.
When a user attempts to open existing 6.0 Students, Grading or Online databases for the first time in 6.1 they will be given the choice to convert that 6.0 database to 6.1 or not (Banks, Tests, and Scores databases do not require conversion):

The database conversion is transparent to the user except for the above prompt.

**NOTE:**

Once a database has been converted from 6.0 to 6.1 it can no longer be opened in 6.0.

**After Installing 6.1**

You may choose to uninstall 6.0 from computers. Uninstalling 6.0 won't delete any of your LXR•TEST data; it simply removes the LXR•TEST 6.0 programs from your computer.

**What’s Different in 6.1?**

The new features in 6.1 have no effect on Banks, Tests, Specs, Scores, and Headers databases but do affect the Students, Grading, and Online databases.

Users will see new fields in the Students, Grading and Online databases:

Students database; new Group Number and Group Name fields:

<table>
<thead>
<tr>
<th>Group Number:</th>
<th>Group Name: Unnamed group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Students:</td>
<td>0</td>
</tr>
<tr>
<td>Selected:</td>
<td>0</td>
</tr>
</tbody>
</table>

Grading database; new Group Number and Group Name fields:
Online database; new Group Number, Group Name, and Student Group fields:

A Recommendation on Numbers of Groups per Database

Although the 6.1 features supports up to 500 groups per database, we recommend limiting that number to a more reasonable (50 or less). When you have a large number of groups the navigation to the desired group can become time consuming. Also, the databases themselves can become quite large to manage. A good practice would be to try and decide on a database organization scheme. Setup multiple databases based on type of tests, class, instructor or whatever makes sense. Another concern is database security. Use of a single database implies that any user who has access to that database has access to all of the data in it. The best way to protect the data of separate entities is through use of separate databases.

Using the 6.1 Features

Students Database

LXR•TEST 6.1 supports multiple student groups in the same Students database.
The first step to implementing multiple student groups is to create an upsized Students database or open an existing one. Information on upsizing can be found in Appendix J of the User’s Guide, or at:

http://lxr.com/support-online-howdoi/support-online-howdoi-upsizeforSQL2000.htm

For the purposes of this documentation the following example assumes a newly created upsized Students database into which existing Students databases will be imported.

Once your upsized Students database is open you can import existing Students databases into different student groups, or create new student groups and enter information manually.

In the following example there will be a newly created upsized database named 'All Students.LXRStudents' and 3 existing Access Students databases; Grade 9 Students, Grade 10 Students, and Grade 11 Students. All 3 Students databases will become individual groups in the 'All Students' database.

**Naming Student Groups**

By default, the Students database will have ‘1’ in the Group Number and ‘<unnamed group>’ in the Group Name fields. Grade 9 Students is to become Group 1 so that is what is typed into the Group Name field.
NOTE:
It’s important to name your groups with as descriptive names as possible to avoid confusion. Group names can be up to 64 characters in length.

Importing into Student Groups
Once the student group has been created we can import an existing Students database into it.

1. File > Import > Next > Students/Native > Next
   • Source: browse to the location of the desired Students database to import. If the Students database to be imported is already an upsized database, use the ODBC button and select the DSN for the desired Students database.
   • In the field below the source path you will see ‘LXRTEST 6.0 group’. If the Students database you were importing from was already a 6.1 database with student groups in it, you would be able to select the student group to import.
   • Destination: the destination database field will be populated with the database you have open and you have the option to ‘<Create new group>’ to import into or select an existing group, such as ‘1::Grade 9 Students’ or any student group listed by clicking on the pull-down in that field. If you import with ‘<Create new group>’, the new Group Name will be the name of the database you imported.
   • Next > Finish
• Upon clicking Finish you should see the message ‘Your import was successful’ and you’ll see that student group populated with the contents of the Students database you imported.

Adding Student Groups

• Right click in the Group Number field and select ‘Add new file group’.

• Name the group in the Group Name field.

• Import an existing Students database or a Merge file containing student records into the new student group or add new student records manually:

• The following shows a Student database containing 3 Student Groups.
Selecting and Navigating Between Student Groups
Once you have a Students database that contains multiple student groups you can go between those groups to display or work with a particular group of student records. You do so by clicking on the pull-down in the Group Number field. The student groups will be displayed in alphabetical order. Click on the desired group and that group will be presented to you.

When you open a Students database the student group that is first in the list of student groups is always the group that will be displayed.

Renaming Student Groups
To rename a student group, simply select the group, click in the Group Name field and modify, or replace the existing group name.

Deleting Student Groups
To delete a student group, simple select the group to delete, right click in the Group Number field, and select ‘Delete Current File Group’.

NOTE:
Deleted Group Numbers are reused.

Exporting Student Groups
Source: Whether exporting to Native or Merge format, by default, whichever student group is the active/displayed group is the one that will be exported as the source; however, there is a pull-down menu from which you can select another group to export.

Destination: when exporting to Native format you have the option to have a new student group created in the destination Students database or you can select an existing group in the destination Students database to which the exported records will be added.

Reports and Student Groups
Which ever student group is the active/displayed group when you select File > Print > Student Reports is the group that the report will represent.

Numbers of Groups,
LXR•TEST 6.1 supports up to 500 groups in the Students, Grading, and Online databases.
Grading Database

LXR•TEST 6.1 supports multiple grading groups (essentially multiple Grading tables) in the same Grading database.

The first step to implementing multiple grading groups is to create an upsized Grading database or open an existing one. Information on upsizing can be found in Appendix J of the User's Guide, or at:

http://lxr.com/support-online-howdoi/support-online-howdoi-upsizeforSQL2000.htm

For the purposes of this documentation the following example assumes a newly created upsized Grading database into which existing Grading databases will be imported.

Once your upsized Grading database is open you can import existing Grading databases into different grading groups, or create new grading groups and load them from banks.

In the following example there will be a newly created upsized database named 'All Grading.LXRGrading' and 3 existing Access Grading databases; Math Grading, English Grading, and Algebra Grading. All 3 Grading databases will become individual groups in the 'All Grading' database.

Naming Grading Groups

By default the Grading database will have '1' in the Group Number and '<unnamed group>' in the Group Name fields. Math Grading is to become Group 1 so that is what is typed into the Group Name field.

**NOTE:**

It's important to name your groups with as descriptive names as possible to avoid confusion. Group names can be up to 64 characters in length.

Once the Grading group has been created an existing Grading database can be imported into it or grading records can be added manually.
Importing into Grading Groups

- File > Import > Next > Grading/Native > Next
  
  - Source: browse to the location of the desired Grading database to import. If the Grading database to be imported is already an upsized database, use ODBC/DSN and select the DSN for the desired Grading database.
  
  - In the field below the source path you will see ‘LXRTEST 6.0 group’. If the Grading database you were importing from was already a 6.1 database with Grading groups in it, you would be able to select the Grading group to import.
  
  - Destination: the destination database field will be populated with the database you have open and you have the option to ‘<Create new group>’ to import into or select an existing group, such as ‘1::Grade 9 Grading’ or any Grading group listed by clicking on the pull-down in that field. If you import with ‘<Create new group>’, the new Group Name will be the name of the database you imported.
  
- Next > Finish
  
- Upon clicking Finish you should see the message ‘Your import was successful’ and you’ll see that Grading group populated with the contents of the Grading database you imported.

Adding Grading Groups

- Right click in the Group Number field and select ‘Add new file group’.
  
- Name the group in the Group Name field.
  
- Import an existing Grading database into the new Grading group or enter grading information manually:
  
- The following shows a Grading database containing 3 Grading Groups.
Selecting and Navigating Between Grading Groups
Once you have a Grading database that contains multiple Grading groups you can go between those groups to display or work with a particular group of Grading records. You do so by clicking on the pull-down in the Group Number field. The Grading groups will be displayed in alphabetical order. Click on the desired group and that group will be presented to you.

When you open a Grading database the Grading group that is first in the list of Grading groups is always the group that will be displayed.

Renaming Grading Groups
To rename a Grading group, simply select the group, click in the Group Name field and modify, or replace the existing group name.

Deleting Grading Groups
To delete a Grading group, simple select the group to delete, right click in the Group Number field, and select ‘Delete Current File Group’.

Exporting Grading Groups
Source: Whether exporting to Native or Merge format, by default, whichever Grading group is the active/displayed group is the one that will be exported as the source; however, there is a pull-down menu from which you can select another group to export.

Destination: when exporting to Native format you have the option to have a new Grading group created in the destination Grading database or you can select an existing group in the destination Grading database to which the exported records will be added.

Reports and Grading Groups
Which ever Grading group is the active/displayed group when you select File > Print > Grading Reports is the group that the report will represent.

Online Database
The Online database has been enhanced to support multiple Online tests in the same upsized Online database, separated and accessible by Group Numbers. Additionally, within each online test, once you have selected a specific Students or Grading database, you can select Groups from within those databases. You can also select a specific Test ID from the associated Scores database.
## Database Synchronization

There have been some subtle changes to the way LXR•TEST 6.1 handles databases when an Online database is open.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Conditions</th>
<th>Behavior</th>
<th>Difference between 6.0 and 6.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new Online database (or new Online group)</td>
<td>Scores and Test already open</td>
<td>The new Online database will associate with the open files.</td>
<td>Same in both versions</td>
</tr>
<tr>
<td>Open an existing Online database (or switch to a different Online group)</td>
<td>Anytime</td>
<td>Any open databases are closed and the databases associated with the Online group are opened.</td>
<td>Same in both versions</td>
</tr>
<tr>
<td>Open a Test or Scores database</td>
<td>Online database already open</td>
<td>The Online database associations will not change</td>
<td>New in 6.1</td>
</tr>
<tr>
<td>Add or switch to a different Test ID in the Scores window</td>
<td>Online database already open</td>
<td>The Online database associations will not change</td>
<td>New in 6.1</td>
</tr>
<tr>
<td>Re-associate databases in the Online window</td>
<td>Anytime</td>
<td>Any previously opened database is closed and the newly selected database will be opened.</td>
<td>Same in both versions</td>
</tr>
<tr>
<td>Opening an Online database that has a conflict between a Test and the Test ID referenced by the Scores database.</td>
<td>Anytime</td>
<td>The Online window will report the condition and attempt to resolve the situation by adding a new Test ID to the Scores database.</td>
<td>Same in both versions except that in 6.0 this situation would occur at additional times making it sometimes difficult for the user to open the files they really wanted.</td>
</tr>
</tbody>
</table>

These changes eliminate the need to worry about recursive synchronization attempts. The responsibility is given to the user to make sure the correct database associations are provided. It also eliminates the possibility of the software inadvertently making unexpected synchronization attempts whenever different databases are opened.
Online Setup Window

Naming Groups

The following example starts with a new upsized Online database named ‘All Web Tests’. Group Number 1 will contain an Algebra web test so “Algebra Web Test” is typed into the Group Name field:

Associating Tests

Note: if you are planning on scoring your exam, do not try to associate a test here. Instead, associate a scores database and select the proper test ID from the scores database (see the Scored Exams section below). If you are not planning on scoring this exam then right click in the 'Test' field and browse to the desired test:
Scored Exams

An upsized Scores database that contains 3 Test ID’s—one each for Algebra, English and Math — is the Scores database that is to become associated with Online Group Number 1. By default, Test ID 1 will be the active Test ID. To change to another Test ID, simple right click in the 'Record Scores to’ field, re-associate, and select a different Test ID from that Scores database.

Online Access Window

If controlling access to an online test via a Students database, right click in the 'Use Students database’ field and associate the desired Students database.
Once the Students database has been selected, the desired Student Group for a particular Online test can be selected from the drop down menu in the Student group field.

**Online Reports Window**

If using a Grading database for reports in an Online test, right click in the ‘Apply Grading from’ field and associate the desired Grading database.
Once the Grading database has been selected, the desired Grading Group for a particular Online test can be selected from the drop down menu in the Grading group field.

**Adding Online Groups**

- In the Setup window right click in the Group Number field and select ‘Add new file group’.
- Name the group in the Group Name field.
- Associate the appropriate other databases for that group.
- The following sequence of images shows adding an Online Group and associating the appropriate databases, etc.:

Right click to add a new file group:
Type in a new name for the group in the Group name field:

Notice in the image above that the test database, the Scores database, and the Test ID from the Scores database didn’t change from what they were set to for Group 1 just by adding a new group.

LXR•TEST 6.1 handles re-association of the Test and Scores databases a little differently than 6.0.

If no Scores database is associated with the Online database, nothing has changed. However, for scored tests the Online window now disables the re-association feature for the Test name. The Test name now comes directly from the Scores database. The Test name displayed in the Online window is the test that is identified by the Test ID chosen by the online test creator. If the online test creator wants to score a different test they must select a different Test ID in the Online window using the re-associate Scores option. If the Test ID does not exist, they must first go the Scores database and add a new Test ID.
To select a different Test, right click in the 'Record Scores to' field and select a different ID or a different Scores database.

Based on the Scores database selected and the Test ID from within that Scores database, the appropriate Test will be opened and associated with the Online test.

If a different Students database is to be associated with this group, go to the Access tab and associate the appropriate Students database or group from within the associated Students database.
Based on the Students database and the Student Group selected, the appropriate Students database will be opened and the appropriate Student Group will be active.

If a different Grading database is to be associated with the Online group, go to the Online Reports window and select the appropriate Grading database and Grading Group from within it.
Navigating between Online Groups
Once you have multiple groups in the same Online database you navigate between them by clicking in the Group Number pull down menu and selecting the Group Number of the Online test that you want to work with. By default, when you open up an Online database that contains multiple groups, the first group in the list will be presented.

Based on the group selected, the appropriate Scores, Students, and Grading databases and the appropriate groups and or Test ID within them will be opened automatically. The appropriate Test and Bank will be opened based on the Test ID specified.

Deleting Online Groups
To delete Online Groups, right click in the Group Number field and select 'Delete Current File Group'.

Renaming Online Groups
Online Groups can be renamed by clicking in the Group Name field and modifying the contents.

Opening 6.0 Databases in 6.1
When opening existing Students, Grading, and Online 6.0 databases in 6.1 you will be prompted whether you would like to convert that database to 6.1 or not. Once the database is converted to 6.1 it cannot be opened again in 6.0.

When opening a 6.0 Students or Grading database in 6.1 it will become Group Number 1 and the name of the group will be the name of the 6.0 database which can then be renamed if desired.

When a 6.0 Online database is opened in 6.1 it will become Group Number 1 and the name of the group will be the name of the 6.0 database which can then be renamed if desired.

When opening a 6.0 Online database in 6.1 if it is associated with 6.0 Students, Scores, or Grading databases, you will be prompted for the conversion of each one.
6.0 Web Tests in 6.1

6.0 Web tests that are opened and converted to LXRTEST 6.1 format will generate different web test URL’s than were generated in LXRTEST 6.0. Whether or not you take advantage of the LXRTEST 6.1 groups feature you do need to take note of the actual URL that is generated. Also note that if you use custom logon, logoff or cover pages that LXRTEST 6.1 generates new default names for the ASP pages that are created.

Online LAN Database

The Online LAN and web databases in 6.0 have a few differences; 6.1 introduces an additional difference:

In the Setup tab in the Online window for LAN exams, the Browse button has been removed from the “Go to test” portion of the Exit Handling section. In its place, a “Re-associate linked exam” option has been added to the right click options of the edit box so that it now behaves consistently with the other database names. Also, an Online group drop down has been added so that the instructor can choose the correct Online group from the specified “Go to test” database.

These changes only apply to LAN exams. Web tests use a URL link so no database name is involved for linked exams.

Other than the differences noted above, the above documentation on 6.1 Online web databases can be applied to 6.1 Online LAN databases.

The 6.1 Student LAN Client is able to read both 6.0 and 6.1 Online exams, meaning that 6.0 LAN exams do not have to be rebuilt in 6.1 in order to be accessed via the 6.1 LAN Student LAN Client. However, if you open and convert a 6.0 student or 6.0 grading table database to 6.1 format and that same database is referenced in a 6.0 Online exam you will also need to convert the 6.0 Online database to 6.1 format.

Recommendation

You are limited to 500 Group Numbers per Online database which means that a single Online database could conceivably support up to 500 individual online tests. Although up to 500 groups are fully supported per database, we suggest limiting the number of groups to a more reasonable number (50 or less). When you have a large number of groups the navigation to the desired group can
become time consuming. Also, the databases themselves can become quite large to manage.

Feedback & Support

LXR welcomes your feedback on the 6.1 features and this documentation. Feedback should be emailed to support@lxr.com. Please put “6.1 Feedback” somewhere in the Subject line.

Should you encounter a problem or have a question when using 6.1, please send an email to support@lxr.com describing the problem or question. Please include “6.1” somewhere in the Subject line.